
Mastering Web Site Development Readme 
File
© Copyright 1997 Microsoft Corporation. All rights reserved.
This document provides late-breaking or other information that supplements the online Help for Mastering 
Web Site Development.

Be sure to check out the Mastering Product Web page, http://www.microsoft.com/mastering. Any 
updates to this Readme file will be posted on the Product Web page. To view the Web page, click Product 
Web Site on the Help menu of Mastering Web Site Development

This Readme file contains important and helpful information on the following topics.

 Send Us Your Feedback
 Setup Issues
 Removing Mastering Web Site Development
 Using the Internet Features of this Title
 Content Issues
 Performance Issues
 Graphics and Multimedia Issues
 Printing Issues
 Technical Support

To read this file online, use the PAGE DOWN and PAGE UP keys. You can also print the file by clicking Print
on the File menu in your Windows-based editor or viewer.

_______________________________________________________
Send Us Your Feedback
We welcome your feedback. Let us know how Mastering Web Site Development has helped you gain 
expertise in creating custom solutions. You can reach us in any of the following ways.

Internet: devtrain@microsoft.com

Mail: Mastering Series Products
Microsoft Corporation
One Microsoft Way
Redmond, WA 98052-6399

Fax: (425) 936-7329
Attn: Mastering Web Site Development

Note that we receive a number of suggestions and comments regarding Microsoft products and are unable to 
respond directly to each one. However, please be assured that your recommendations, ideas, and remarks 
will be recorded and will help shape future versions of our Mastering Series products.

_______________________________________________________
Setup Issues

 General Notes: Here are some general notes for setting up this title:
 The default settings for the Setup program will load Mastering Web Site Development on your C: drive 
in the MWD folder. You can assign application files to a different drive; however, Setup will copy as much as 8.5 MB 
of system files to your Windows \System folder.
 Because this title installs system files that may be shared with other applications, you must close any 
open applications before running Setup. 
 If you close all open applications and encounter problems during Setup, make sure your system meets 
the minimum requirements necessary to install this title.
 Do not remove the Mastering Web Site Development CD-ROM during Setup, or attempt to start the 
application, before Setup is complete. 
 The User Profile used for Setup must be used to run the title: If you change the User Profiles in Windows



95 or Windows NT 4 after installing this Course, continue to log on to your computer with the same user name you 
originally used during installation. Other users who may have altered the default User Profiles settings will experience
a path error message when restarting the Course. To avoid this problem, use the original user name. 
 Your hard drive must have a Temp folder: If a C:\Temp folder does not exist on your hard drive, this title 
will fail to run. The splash screen will appear, and then the run-time error with the error message "3043 Disk or 
Network Error" will be displayed. To fix this error, create a folder named Temp on your C: drive. 
 Advanced Data Connector 1.0 does not install on Win95:    The Advanced Data Connector 1.0 does not 
install on Win95. Although the setup will run successfully, the files will not be copied onto the computer correctly. 
This problem affects Lab Exercises 7.2, 8, and 9 if you are using Win95 personal web server. This problem does not 
affect running the labs on NT IIS 3.0. Future releases of the Advanced Data Connector will address this problem.. 
For information on new versions of the Advanced Data Connector, see the Advanced Data Connector home page at 
http://www.microsoft.com/adc. 

System Requirements
Mastering Web Site Development will run on the following minimal system; however, performance will improve
with more RAM or a faster CD-ROM drive.

 Personal computer with a 486DX or higher processor, running Windows 95 or Windows NT 4.0 or later
 8 MB of memory (16 MB or more recommended) for Windows 95; 12MB (20MB recommended) for Windows 

NT 4 Workstation
 10 MB of available hard-disk space (20 MB to work with the lab files on your hard drive)
 MPC2-compatible CD-ROM drive
 Super VGA or higher-resolution video adapter capable of displaying 256 colors or greater
 Microsoft Mouse or compatible pointing device
 MPC2-compatible audio board

_______________________________________________________
Removing Mastering Web Site Development

 To remove this title: Run Setup again and click the Remove All button. You can also uninstall the program 
by using the Control Panel to run the Add/Remove Programs application. 
 Possible additional steps: To completely remove this title, you may also need to do the following:

 Delete the Mastering Web Site Development shortcut. If you moved the shortcut to a different 
folder after installing the application, Setup will not be able to detect the location of the new shortcut 
or delete it. After running Setup (with Remove All), delete the shortcut(s) from the Start Menu. 

 Delete the MWD folder. The MWD folder (or the folder you specified as the destination folder during 
Setup) will not be removed because it may contain files that you modified. If you did a Complete 
installation during Setup, the two folders \MWD\Lists and \MWD\Labs were added. If you worked on 
any of the labs or added topics to the Course Notebook, the information is saved in these folders. If 
you want to remove these folders, select each of these folders in Windows Explorer, and press 
DELETE.

Warning    When running Setup with the Uninstall option, you may receive a dialog box with a warning 
message about deleting a shared file. This message is displayed only when Setup prepares to remove a file 
that another application may need to use. If you remove the file, be aware that other unregistered applications 
using the same file may no longer run correctly.

_______________________________________________________
Using the Internet Features of this Title
The Mastering Web Site Development title includes the following Internet access features. 
Launching URLs
This product contains Universal Resource Locators (URLs) that you can launch to view related Web sites on 
the Internet. 
Web jumps may be out-of-date: Note that at the time this course was released, all the Web sites listed in it 
were valid and fully functional. However, as the World Wide Web evolves, you may find that an Internet Jump 
provided in this title is no longer valid. If this happens, try searching the Web for the site, or connect to the 
Mastering Series Web page on the Microsoft Web site (http://www.microsoft.com/mastering) to see if updated 
URLs are listed.



The title may start two instances of Internet Explorer: If Internet jumps in the title do not appear to work, 
but an instance of the Internet Explorer is running (as shown in the Task Bar or the Close Program dialog box)
the Internet Explorer window may be in a state in which it's normal window size has been set to minimized. If 
you right-click on Internet Explorer in the task bar, and select "Maximize", the IE window will now appear in a 
maximized state (demonstrating that it is still working properly). But the window cannot be resized, only 
minimized or maximized. To fix this: 
Minimize all windows, including Internet Explorer. Keep that instance of Internet Explorer running.

1. Start a second instance of Internet Explorer. (Double-click the "Internet Explorer" icon on the 
desktop.)

2. A very small Internet Explorer window will appear. Resize this window to the desired size.
3. Close the first, minimized instance of Internet Explorer.
4. Then close the resized instance of Internet Explorer. This will preserve the window's settings.

Product Web Site
To jump to the Mastering Series Web page, click Product Web Site on the Help menu. This site 
(http://www.microsoft.com/mastering) will contain any future errata information, and pointers to additional 
information about this title and other Mastering Series titles.

Internet Explorer 3.0 
Both these Internet features require Microsoft Internet Explorer 3.0 or later. If you have an early version of 
Internet Explorer, you will not be able to automatically launch URLs from within the title. You can download 
Internet Explorer from the Microsoft Web site http://www.microsoft.com/ie or from the folder on the 
Mastering Web Site Development CD labeled MSIE3.1. 

_______________________________________________________
Content Issues
This section provides extra information about the contents of Mastering Web Site Development, and describes
problems you may experience while running the title.
 Size limit on notes in Notebook: If you paste in individual notes larger than 32Kb, the Notebook may 

eventually function improperly. If your Notebook stops functioning, close Mastering Web Site 
Development, and use the Windows Explorer to delete the file "<name>notebook.lst" (where <name> is 
your user logon name, or blank if you are not logged onto the machine in Win95). Note that you will lose 
all of your saved Notebook entries if you do this. You should periodically back up the contents of your 
Notebook.

 Installing Demo and Lab Code: The starting and solution code for the labs will be copied to your 
computer if you specify the Complete Installation option when installing Mastering Web Site Development.
Demonstration code is not installed, but can be found on the Mastering Web Site Development CD-ROM 
under the subdirectory \Demo Code. If you wish to edit the demonstration code, then you must:

1. Copy the corresponding project to your hard disk
2. Change the directory and file attributes for the project from read-only to read-write. (In the 

Windows Explorer, highlight the copied files, then choose the Properties command from the File 
menu, and de-select the Read-Only checkbox.)

 Library articles: Library articles included in this title are not edited by the Mastering Web Site 
Development team. You may encounter documentation errors, references to page numbers or files, and 
formatting problems. Addresses, phone numbers, and other contact information appearing in this title may
have changed since the time of publication. 

 Topic titles: Some of the topic titles in this Course may be cut off when running this title in lower 
resolutions. 

 Navigation and Topic panes: If you use the keyboard to navigate through the Contents in the Navigation
pane or the topics in the Topic pane, you may need to change the focus of the application, depending on 
what you want to view. To change the focus, click the pane in which you want to navigate. On some 
systems, the vertical scroll bar may change size when scrolling through the topics and labs, or navigating 
through the Contents.

 Known Issues with the StateUFinal Web site
 The State University Web site was designed and tested with Microsoft Internet Explorer 3.02.
 State University uses unsigned ActiveX controls on the Mascot page and the Class Registration page. Therefore,

you must set the Safety Level of Microsoft Internet Explorer to Medium or None.
 When you first go to a page in the Web site, you need to enter a valid Student ID (1-57) on the Profile page, 

profile.asp, and click Submit. If you don't click Submit, you won't be able to get a transcript or register for 



courses. Only the Student ID entered on the Profile page is used throughout the Web site; you can enter any 
name and major, or leave them blank. 

 On the home page, home.asp, nothing happens when you click on a course name in the popup menus of 
courses.

 When you first go to the Register for Course page, classview.htm, an unsigned control is installed on your 
computer. Because there is client-side script trying to access control before it is completely installed, you get a 
VBScript runtime error on the page. You need to refresh the page for the script to run without errors. 

 On the Mascot page, mascot.htm, typing the ENTER key causes the page to reload.
 If you have trouble running this Mastering title:    If your computer has only the operating system 

installed, a problem can occur when running Setup, particularly on Windows NT. Some DLLs needed by 
Microsoft Visual Basic 5 (used in the Mastering application) may not register properly. To correct this 
problem, install Internet Explorer from the Mastering CD, or any of the Microsoft programming tools used 
by the labs. Doing either of these correctly loads and registers the needed DLLs. You may also need to 
reinstall the Mastering Series title.

_______________________________________________________
Performance Issues
There are several ways to cause this title to run faster. 

 Increase your machine's available memory: This title uses your computer's random access memory 
(RAM) to display illustrations and play video and audio. If this title runs too slow, or if you get error messages saying 
you are out of memory, you may not have enough available RAM. Following are some tips to make the best use of 
your computer's available memory.

 Close all open applications that are not being used. 
 Add more RAM (memory) to your computer. You can determine how much memory is available by 

starting MS-DOS, typing mem and pressing ENTER. You need at least 8 MB of RAM (16 MB is 
recommended).

 If you are using more than 256 colors in your video display, you may want to lower the colors to 256. 
For information about how to change your Windows display, consult your Windows documentation.

 For more information: Consult your Windows 95 and CD-ROM documentation for more information about 
improving performance.

_______________________________________________________
Graphics and Multimedia Issues
There are several issues you may encounter while viewing the graphics and multimedia in this Course:
 Video files require Windows 95 Multimedia options: The .avi files will run only if you have installed the

Multimedia options when setting up Windows 95. Setup will look for multimedia options on your system 
and notify you if they are not installed. If this is the case, you will need to install the appropriate options. 
Even with appropriate hardware, you may experience long wait times while video files are being loaded, 
and you may encounter errors in audio/video synchronization during playback.

 Closed Captions Show Best in Three Line or Four Line View: Due to current jumps in scrolling pace, 
a One or Two line view of Closed Caption text can miss lines when they scroll past. To avoid this, use the 
Lines command in the View menu of the media viewer to set the closed captions view to Three lines or 
Four lines.

 Palette flashes may occur if monitor not set to High or True Color: Palette flashes can occur when 
switching between Mastering Web Site Development and other running applications, or when starting or 
stopping animations and demonstrations. To remove palette flashes, set your monitor color level to High 
Color (16-bit) or True Color (24-bit).

 800x600 is the Recommended Resolution: This title is designed to run on machines capable of displaying 
256 or more colors. Although the title does run on systems displaying 16 colors, there is a noticeable reduction of 
image quality. When running at a resolution 640 x 480, some of the larger graphics may be displayed out of the active
window. It is recommended that you run this title at a resolution of 800 x 600 or greater. 
 Restart the Title after Changing Resolution: You will need to restart the title after you change your screen 
resolution, or the Navigation Pane may not work properly. 
 Some video drivers may cause videos to be garbled or cause system to crash: In some rare situations, 
this title may encounter display problems when using accelerated video drivers, video drivers with more than 256 
colors, or high-resolution video drivers. One example is a video display with garbled images; another is a crash that 
occurs when attempting to play a video. If you do encounter such problems, there are several things you can do.

Most problems can be fixed by obtaining new drivers from your video card manufacturer. Contact the 
manufacturer of your video card to determine if newer versions are available. The manufacturer's phone 



number should be included with the documentation that came with your video card or computer. 
Another option for obtaining updated drivers is to use the Microsoft Download Service (MSDL), an 
electronic bulletin board that can be accessed by modem at (425) 936-MSDL.
The drivers provided on MSDL are compressed with the PKWare utilities, and are in the form of 
executable files. It is best to download the file or files you need into an empty folder on your hard disk or 
onto a blank formatted floppy disk. To decompress these drivers after downloading them, either:

 Double-click the file name you downloaded from the Windows Explorer.. 
-or-

 From the DOS prompt, change to the directory that contains the downloaded file, type the file 
name, and then press ENTER.

An alternative to obtaining a new or updated display driver is to change your video mode to a standard 
video mode, such as a 640 x 480 resolution with 256 colors.
To find out what video driver you are using, double-click Display in the Control Panel. In Windows 95, 
click the Settings tab, and then click the Change Display Type button. For information about how to 
install or change drivers, click the Help button.

 Illustrations can be Selected for Copying: You can copy and paste illustrations by selecting them. When 
an illustration is highlighted, it appears in inverse video. If an illustration appears to be in inverse video for no 
apparent reason, try deselecting it by clicking elsewhere on the screen. 

 Setting Text and Background colors: This title uses your system settings to display some foreground 
and background colors. You may want to choose a compatible display combination (such as the Windows
standard color scheme) for best results. 

 Application May Lose Focus Displaying Glossary Items: When displaying the Glossary pop-up window, 
the application may lose focus. To correct this problem, click the Topic area, and focus will return to the application.

_______________________________________________________
Printing Issues
General Notes: Here are some general notes for printing with this title:

 Screen resolution and printer resolution are often not the same, so when you print, the result may not match 
the quality you see on the screen.
 If you encounter a general protection fault when you print a topic, check your printer driver. Switch to a more 
current version of the driver, if one is available. Make sure your printer is online and that you can print to it from 
another application. If the problem persists, open the Property page for the printer you are using. Click the Fonts 
tab, and then select the method of downloading TrueType fonts that works best with your system. 
 If you are using an HP LaserJet printer, make sure that you have the most current printer driver, or try setting 
the printer resolution to 300 dpi (graphics may not print properly at 600 dpi). 
 You should be able to print grayscale images from this title. If you have a black and white laser printer, you 
may need to upgrade your printer driver. Call the dealer from whom you bought the printer or call the printer 
manufacturer.
 When printing the current screen, the media elements represented by icons (illustrations, sample code, tips, 
and self-check answers) will not print. To print this information, click Print on the File menu when the media element 
is displayed in the active window. If you experience problems printing over a network, consult your network 
administrator to make sure your printer settings are correct. The solutions for common printing problems are 
described in the section "Printing Problems" in this Readme file. If you want to print the Glossary, the entire Glossary 
will print. 

_______________________________________________________
Technical Support
For help on Setup and product features:
 Check Help.
 Take the Tour, which is accessible through the Welcome screen of the Course or through Help.
 Check the Mastering Series web site to see if any Readme update information has been posted for this 

title.

For phone support:
 In the United States, no-charge support is available between 6:00 AM and 6:00 PM Pacific Standard time,

Monday through Friday, excluding holidays at (425) 635-7033 (this is a toll call).
 In Canada, support engineers are available between 8:00 AM and 8:00 PM Eastern Standard time, 

Monday through Friday, excluding holidays at (905) 568-3503 (this is a toll call).
 Outside North America, contact your local Microsoft subsidiary.




